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Abstract

This CI Lab 900 report series includes a toolset called APm (APproach merotopy). This toolset
facilitates measurement of the degree of nearness between regions-of-interest (ROIs) in pairs of digital
images (either colour or greyscale images). Such nearness measurements are computed in terms of ε-
neighbourhoods contained in selected ROIs. Each neighbourhood contains points y that are descriptively
near a selected centre point x0 in a particular ROI, i.e., the distance between the feature vector of x 0 and
the feature vector for each y is less than some ε ∈ (0,∞]. A feature vector constitutes a description of a
point. In the case of a digital image, a point is defined to be an image pixel.

Key Words: Digital image, distance, feature vector, merotopy, nearness, neighbourhood, region-of-interest
(ROI).

Figure 1: Main APm window

Figure 2: APm Project window

1 Introduction

This report briefly explains how approach merotopic spaces can be used in the study of ε-near collections of
subsets in pairs of digital images. The solution to this problem arises from M. Katětov’s observation [5] that
merotopic spaces are obtained by topologising certain parts of a nonempty set, recent work by S. Tiwari on
approach nearness and merotopological spaces [15] and the introduction of an approach merotopy derived
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from E. Čech’s suggestion [16] that the distance between sets be measured in terms of the greatest lower
bound of the Hausdorff lower distance [4] between points and sets. The details concerning the underlying
theory for the APm toolset are given in the Appendix of this report. For a more detailed explanation of
merotopies with a number of examples (including an application of the APm toolset), see [12].

2 Steps to Use APm Toolset

To use the APm toolset to measure the nearness of selected ROIs in a pair of digital images, do the following.

(Step.1) Use the APm zip file to set up a directory containing the AMm toolset files.
(Step.2) Double click on APm.exe and the main APm window will be displayed (see Fig.1).
(Step.3) Click on the Project tab in the upper lefthand corner of the APm display,
(Step.4) Click on the Load option in the Project menu. At this point, a Project window will appear (see

Fig. 2) showing one file, namely, merotopy.damn. Click on merotopy.damn and then click the
Open button. This loads the merotopy project.

(Step.5) Click on the File tab in the upper lefthand corner of the APm display,

Figure 3: APm Device Driver window

Figure 4: APm Assembly window

(Step.6) Click on the Load assembly option in the File menu. At this point, an Device driver window
will appear showing several dll files (see Fig. 3). Click on NearFiltersTools.dll and then click
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the Open button. This loads the merotopy assembly and an APm assembly window will appear
(see Fig. 4).

Figure 5: APm Action Choices window

(Step.7) Click on the first of the 3 buttons (nested boxes) in the tiny menu in the lower lefthand corner of
bottom of the APm display. As a result, a directed graph (dg) is displayed. Each node in the dg
is represented by a light bulb.

(Step.8) Right-click on the light bulb labelled Start here (see Fig.5). This will display three windows
Window.1 Current directory window showing digital images that can be selected. Select

first image and then Click the Open button. Select second image and then Click
the Open button. The pair of selected images will then be displayed in separate
windows. See, for example, camouflaged man in Fig 6.1 and Fig. 6.2.

Window.2 Epsilon picker window with a slider that makes it possible for you to select a ε
value, starting a ε = 1. Pick a ε value. See, for example, sample ε-picker window in
Fig. 6.3.

Window.3 Merotopy window that starts working after you select a pair of ROIs. To see this,
use the cursor to select a small rectangular region (ROI) in each of the displayed
images. The default features that can be selected in the current version of APm
are Average Edge Direction and Intensity. Try changing the selected features to
obtain a merotopy value. Each increase in the selected ε value leads to a longer time
to compute a merotopy value. See sample merotopy value shown in Fig.6.4.
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6.1: Liu 1 6.2: Liu 2 6.3: Picker 6.4: ν

Figure 6: Sample Use of APm

3 About the APm Toolset

The APm framework facilitates easy creation of image analysis as well as data mining applications from
smaller tasks. The system consists of a main application that allows for creation of projects consisting of
tasks. A task is built by a researcher or developer with favourite tools as long as each task compiles to .NET
libraries.

Figure 7: APm Snapshot

These libraries are then loaded by the APm
framework and executed. The communication be-
tween tasks within the APm framework is via
messages. Each task is built as a separate library
that can be reused by many APm projects. The
project used for this article consists of 12 tasks.
After images are loaded and a user selects ROIs,
probe function values are extracted. Currently two
probe functions (pixel greylevel intensity and Pre-
witt gradient estimate) are used and the extension
by additional probe functions can be done with-
out recompiling the original project. Once probe
functions are ready, they are passed to the mero-
topy, tool where a merotopy distance is calculated
and displayed (see Alg. 1 for details).

Only sample results using APm are given in
this section. After loading a pair of images, the
cursor is used to select an ROI in each image.
Then it is possible to move the ε-picker in Fig. 6.3 up or down to find a case so that the distance νDρ∥⋅∥

approaches zero.

4 Appendix A: Approach Spaces and Čech Distance Between Sets

Approach spaces and ε-approach merotopic spaces are briefly explained in this Appendix. Let X be a
nonempty set. The family of all subsets of X is denoted by P(X) and the collections of subsets in P(X) is
denoted by P2(X). For collections A, B ∈ P2(X), A ∨ B ≡ {A ∪B ∶ A ∈ A, B ∈ B} and A ∧ B ≡ {A ∩B ∶

6



Algorithm 1: APm Merotopy Algorithm
Input : Images A,B and ROIA,ROIB.
Output: Merotopy distance between ROIs.
Convert ROIs to greyscale images;
Use probe functions to extract values in pixel feature vectors;
Select ε value;
Define ROIs as collections of neighbourhoods NDρ∥⋅∥

(xA, ε),NDρ∥⋅∥
(xB , ε);

more := true;
while (more) do

Select xA ∈ ROIA,xB ∈ ROIB;
Extract NDρ∥⋅∥

(xA, ε) ⊂ ROIA,NDρ∥⋅∥
(xB , ε) ⊂ ROIB;

A ≑ {A ∶ A ≑ NDρ∥⋅∥
(xA, ε) ⊂ ROIA} ⊃ NDρ∥⋅∥

(xA, ε);

B ≑ {B ∶ B ≑ NDρ∥⋅∥
(xB , ε) ⊂ ROIB} ⊃ NDρ∥⋅∥

(xB , ε);

if (no additional points remain to be selected in ROIA,ROIB) then
more := false;

Compute νDρ∥⋅∥
(A,B) ≑ Dρ∥⋅∥

B∈B,A∈A

(B,A);

A ∈ A, B ∈ B}. A corefines B (written as A ≺ B) if, and only if, for all A ∈ A, there exists B ∈ B such that
B ⊆ A.

Definition 1. An approach space (X,ρ) [10, 11] is a nonempty set X equipped with a distance function
ρ ∶ P(X) × P(X) �→ [0,∞] if and only if for all nonempty subsets A,B,C ∈ P(X), ρ satisfies properties
(A.1)-(A.5), i.e.,

(A.1) ρ(A,A) = 0,
(A.2) ρ(A,∅) = ∞,
(A.3) ρ(A,B ∪ C) = min{ρ(A,B), ρ(A,C)},
(A.4) ρ(A,B) = ρ(B,A),
(A.5) ρ(A,B) ≤ ρ(A,B(α)) + α, for every α ∈ [0,∞], where B(α) = {x ∈ X ∶ ρ({x},B) ≤ α}.

It has been observed that the notion of distance in an approach space is closely related to the notion of
nearness [7, 6].

Definition 2. C̆ech Distance Between Sets
For a nonempty subset A ∈ P(X) and a nonempty set B ∈ P(X), define a gap functional, a variation of the
distance functions introduced by E.C̆ech in his 1936–1939 seminar on topology [16] (see, also, [2, 3, 9]),
where Dρ ∶ P(X) × P(X) �→ [0,∞] is defined by

C
D
ρ

(A,B) =
⎧⎪⎪
⎨
⎪⎪⎩

inf {ρ(a, b) ∶ a ∈ A,b ∈ B}, if A and B are not empty,

∞, if A or B is empty.

For simplicity, we also write Dρ(A,B) to denote the C̆ech distance between sets.

Observe that (X,Dρ) is an approach space.
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5 Appendix B: Merotopy and ε-Approach Nearness

Merotopic distance is briefly explained in this section. Let A,B ∈ P2(X). Suppose that A and B are two
distinct images. In an approach merotopic space (X,ν), A is said to be near (similar) to B if and only if
there exists subimages A ∈ A and B ∈ B such that ν({A},{B}) = 0 (cf. [11]). In practice, this seldom
occurs. The sets A and B can be close enough and not far apart. Therefore, a function that measures the
almost nearness (ε-nearness, ε ∈ (0,∞]) of collections of sets is required, i.e. we are considering the more
general nearness measurement ν({A},{B}) < ε. This mainly motivates the introduction of an ε-approach
merotopy on X [13]. In this section, we axiomatize ε-approach nearness spaces, where ε ∈ (0,∞], to
study the topological properties of ε-approach merotopic spaces. Examples are constructed in support of the
existence of such spaces.

Definition 3. Let ε ∈ (0,∞]. Then, in a manner similar to [15], a function ν ∶ P2X×P2X ∶�→ [0,∞] is an
ε-approach merotopy on X if and only if for any collections A,B,C ∈ P2(X), the properties (AN.1)-(AN.5)
are satisfied:

(AN.1) A ≺ B �⇒ ν(C,A) ≤ ν(C,B),
(AN.2) (⋂ A) ∩ (⋂ B) ≠ ∅ �⇒ ν(A,B) < ε,
(AN.3) ν(A,B) = ν(B,A) and ν(A,A) = 0,
(AN.4) ∅ ∈ A �⇒ ν(C,A) = ∞,
(AN.5) ν(C,A ∨ B) ≥ ν(C,A) ∧ ν(C,B).
The pair (X,ν) is termed as an ε-approach merotopic space.

Def. 3 gives the properties required for a distance function with two arguments to be an ε-approach
merotopy. Approach merotopies with two arguments were introduced in [13]. Such merotopies are useful
in measuring the distance between nonempty collections. For an ε-approach merotopic space (X,ν), we
define: clν(A) = {x ∈ X ∶ ν({{x}},{A}) < ε}, for all A ⊆ X. Then clν is a Čech closure operator on X.

Let clν(A) = {clν(A) ∶ A ∈ A}. Then an ε-approach merotopy ν on X is called an ε-approach nearness
on X, if the following condition is satisfied:

(AN.6) ν(clν(A), clν(B)) ≥ ν(A,B).

In this case, clν is a Kuratowski closure operator on X [8, p. 20]. This was recently pointed out by
S. Tiwari [15, p. 16] in a review of the Čech closure operator, merotopy on a set, nearness and farness
structures.

Definition 4. For any ε-approach nearness spaces (X,ν) and (Y, ν′), a map f ∶ X �→ Y is called a
contraction if ν′(f(A), f(B)) ≤ ν(A,B), for all A,B ∈ P2(X).

6 Appendix C: Descriptive Nearness of Collections

In this appendix, we briefly consider the perceived distance between descriptions of collections of pixels in
digital images such as those shown in Fig.8. The distance function ρ

∥⋅∥
is defined in the context of a normed

space. Let X be a linear space over the reals with origin 0.
A norm on X is a function ∥ ⋅ ∥∶ X → [0,∞] satisfying several properties for a normed space [14].

Each norm on X induces a metric d on X defined by d(x, y) =∥ x−y ∥ for x, y ∈ R [1]. For example, let a⃗, b⃗
denote a pair of n-dimensional vectors of numbers representing object feature values (e.g., positive real val-
ues representing intensities of light reflected from objects in a visual field), i.e., a⃗ = (a1, . . . , ai, . . . , an), b⃗ =
(b1, . . . , bi, . . . , bn) such that ai, bi ∈ R

0+. Then, the distance function ρ
∥⋅∥

∶ Rn × R
n → [0,∞] is defined,
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A
A B

B

IΩ
νDρ∥⋅∥

(A,B) < ε

Figure 8: Near Images

e.g., by the ∥ ⋅ ∥1 norm called the taxicab distance, i.e., ρ
∥⋅∥

(a⃗, b⃗) =∥ a⃗− b⃗ ∥1= ∑n
i=1 ∣ai −bi∣. For example, let

a⃗, b⃗ denote a pair of n-dimensional vectors of numbers that are positive real values representing intensities
of light reflected from objects in a visual field, i.e., a⃗ = (a1, . . . , ai, . . . , an), b⃗ = (b1, . . . , bi, . . . , bn) such
that ai, bi ∈ R+. For this reason, we introduce Dρ

∥⋅∥
∶ P(X) × P(X) → [0,∞] defined by

Dρ
∥⋅∥

(A,B) =
⎧⎪⎪
⎨
⎪⎪⎩

inf {ρ
∥⋅∥

(a⃗, b⃗) ∶ a ∈ A,b ∈ B}, if A and B are not empty,

∞, if A or B is empty.

Then Dρ
∥⋅∥

(A,B) is a norm gap functional that is defined in terms of ρ
∥⋅∥

to measure the lower distance
between the descriptions of objects in a pair of non-empty sets A,B.

φ(b)

φ(a) A

B
B

A

Fig. 3 Sample Nbds A and B

7 Appendix D: Neighbourhood Interpretation of Nearness

The intuitive notion of nearness translates into the more manageable notion of a neighbourhood (nbd). For
a point x ∈ X, an open nbd Nd(x, ε) with centre x ∈ X and radius ε ∈ (0,∞] is always a subset of X, if we
consider

Nd(x, ε) = {y ∈ X ∶ d(x, y) < ε}.

For simplicity, we will use the notation N(x) to denote a neighbourhood (nbd) and think of a nbd intuitively
by associating with each point x ∈ X an open set N(x), where x belongs to the interior of a nbd N(x).

The nearness of collections of neighbourhoods of points contained in regions of interest (ROIs) in digital
images is considered, next.

Definition 5. ε-Near Collections [13]. A nonempty collection A is ε-near a collection B if, and only if
there are B ∈ B,A ∈ A such that ν(A,B) < ε. A nonempty collection A is descriptively ε-near a nonempty
collection B (denoted by A !

Φ
B) if, and only if a description merotopy

νDρ∥⋅∥
(A,B) ≑ Dρ∥⋅∥

B∈B,A∈A

(B,A) < ε,

for at least one B ∈ B that is near at least one A ∈ A. When A !
Φ

B applies, then one or more probe functions

are used to define pairs of feature vectors, one for each collection.

Example 1. The pair of • bullets in Fig. 3 each has a feature value extracted with probe φ. The egg-shaped
regions labelled A,B in the foreground represent descriptively similar neighbourhoods. If we consider only
greylevel intensity of the pixels in A,B, then, by definition, for some choices of ε, Dρ∥⋅∥

B∈B,A∈A

(B,A) < ε.
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